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2. INTRODUCTION 

Introducing Spark Color 3™, the most affordable way to get robust color-mixing with top-quality sound from a mid-

range board. By combining the simplicity of Spark 3™ with a unique four-channel color-mixing platform, Spark 

Color 3™ is packed with awesome features such as the following: 

 Color mixing is independent of fonts – set each color-set separately from each font, allowing all the colors 

to be used from all the fonts! 

 Easy setup – with only a few tabs in the NEC Editor, setup is a breeze while still allowing effects 

personalization. 

 Use the on-board color editor and motion editor configuration apps to easily dial in color and motion 

settings, without having to remove the SD card. 

 True 16bit DAC for sound quality normally only reserved for high-end boards. 

 Motion Sense V2 for the best swing and clash detection from a production board. 

All of these features are packed into the same 2.07” x 0.85” x 0.238” packing with the TruDrive attached, and 

1.75” x 0.85” x 0.238” with the TruDrive removed, for easy installation into any hilt. 

2.1. NEW IN SPARK COLOR 3™ 

There are many improvements in Spark Color 3™ from the Spark Color 2™ platform. The following are the main 

improvements: 

HARDWARE 

 16bit off-CPU DAC for crystal-clear audio from all 8ohm speakers. 

 Motion Sense V2 ported from Igniter 3™, most accurate motion detection in a production board. 

FIRWMARE 

 Error LED as part of bootstrapper and main app. 

o Blinks for SD card error, config file errors, and wav errors 

o Also blinks for warnings such as missing wavs (see <> below) 

2.2. NEW IN SPARK COLOR 3™ R2  

The following features have been added to the SC3-R2 release: 

 EzClash™ improvements. By holding the aux button before performing the clash, the effect will directly go 

into the lockup, skipping the clash altogether. If you do a clash and hit the aux, it will behave as before. 

 Pixel Support. No longer are you limited by certain brands of pixel strings; now Spark Color 3™ supports all 

kinds of strings on the market, including the notoriously finicky ALotive. 

 RGBW Pixel Strings! Related to the above addition, Spark Color 3™ R2 now supports RGBW SK6812 pixel 

strings. These can be purchased from BTF Lighting on Amazon among other suppliers. 

 



Page | 6 

 

2.3. NEW IN SPARK COLOR 3™ R3 

SC3-R3 comes with the new RealSwing™ feature! The next iteration in the MotionSense V2 engine, this system 

tracks motion in real time, playing the appropriate swing bank and appropriate pitch and volumes as well. This 

allows for precise swings that match the motion at any speed. Further, all swing sounds are based off the same 

swing files, so it is a more matched sound than smoothswing can provide. 

2.4. COLOR MIXING 

Color mixing is done a bit differently in Spark Color 3™. Unlike Igniter 3™ and Spark 3™ which utilizes a color for 

each font, Spark Color 3™ has nine (9) color-sets which are independent from the fonts. A color-set consists of a 

main blade color, a clash color, and a blaster block color. These colors are stored on disk in the folders colr1, colr2, 

…, colr9. They can be edited from both the Configuration Editor on the computer, or from the Color Editor by 

booting the saber with the aux button pressed. The latter allows color editing in real time! 

To change colors, simply perform the DualPhase™ motion from Igniter™ when a font is running. This will advance 

to the next color-set. When the last color-set is reached, it will start again at the first. 

When performing the retraction, the current color-set is remembered, so that going to the next font will not reset 

the color-set. Going to any font and performing the extension will be for the last used color-set. Inserting the kill 

key or cutting power to the board will reset the color as the board always launches in the first color-set. 

 

3. GETTING STARTED 

3.1. IMPORTANT NOTES 

PLEASE READ THIS SUBSECTION CAREFULLY AS FAILURE TO DO SO COULD CAUSE DAMAGE TO THE SPARK™ 

BOARD. 

3.1.1. 3.7V POWER SUPPLY 

Spark Color 3™ is designed around a 3.7v power supply input. In general, the best way to run a Spark Color 3™ is to 

hook up a single 3.7v battery to the VBATT+ and VBATT-/GND pads. 

NEVER HOOK A 7.4V BATTERY DIRECTLY TO A SPARK COLOR 3™ UNDER ANY CIRCUMSTANCES, OR 

YOU WILL DESTROY THE BOARD. 

NEVER REVERSE THE POLARITY OF VBATT+ AND VBATT-/GND. IF USING A CONNECTOR FOR THE 

BATTERY, MAKE SURE TO USE ONE THAT ONLY CLIPS IN ONE WAY TO PREVENT DAMAGING THE 

BOARD BY HOOKING THE POWER IN REVERSE. 

3.1.2. BATTERY PROTECTION 

Only use li-ion batteries that have a built-in protection circuit. NEVER USE UNPROTECTED CELLS AS THIS CAN 

CAUSE DAMAGE TO THE BATTERY AND/OR SPARK COLOR 3™. IMR batteries are okay but since they are not 
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protected they can allow large amounts of power to the board and do not act like a fuse when there is a wiring 

issue, so for beginners it is recommended to use the standard Li-ion with the protection circuit. 

3.1.3. BATTERY BRANDS 

Because only one battery is being used, it is very important that a quality battery is selected to get the best 

experience from Spark Color 3™. From internal testing, it is determined that the best batteries are ones with a 

10amp protection circuit or higher. Specifically, the following batteries meet this criteria: 

 KeepPower 18650 3120mAh 15amp PCB 

 KeepPower 18650 3400mAh 10amp PCB 

 Solo’s Hold 18650 15 amp PCB 

 Solo’s Hold 18650 10 amp PCB 

When using a pixel string blade, or a cross-guard setup a 10amp PCB battery MUST be used. Failure to do this will 

lead to the board shutting down unexpectedly during effects. 

3.1.4. BATTERY SIZE 

The only battery that is recommended is the 18650. A 26650 can work as well if more runtime is desired. I do not 

recommend a smaller battery as there are none that are known to have at least a 10amp PCB. 

3.1.5. LED CHOICES 

When using Spark Color 3™ with a 3.7v power source the LEDEngin LEDs will not work well. This is because 

LEDEngin’s green and blue dies require a forward voltage of 4.0v for maximum brightness. Thus it is highly 

recommended to use the NECree RGB Red/Green/Royal Blue LED sold here at Naigon’s Electronic Creations. 

http://saberigniter.com/NECreeRGB.aspx 

The NECree RGB produces the brightest, most even blade for an in-hilt LED, but it also is pre-wired for 3.7v with a 

diode built-in for the red, so no external resistors are needed. The standard TriCrees work as well but will require a 

resistor for red, and a bit more wiring to connect all the positives together. 

3.1.6. PIXEL STRING CHOICES 

Not all pixel strings are created equal. There are two sizes 5050 and 3535, with the former having better density, 

but the latter are thinner and fit in a blade better with less vertical shadowing. The IntelliBlade™ was designed to 

be the best of both worlds and is the best choice, but I’ve put that product on hold due to the cost to manufacture 

and fragility of shipping making the product not worth the investment. 

When purchasing a strip, make sure it has at least 144 LED/M; anything less dense will have way too much corn-

cobbing, with blotches of brightness up the blade. 

The best strips currently available to use are the NeoPixel strings from Adafruit: 

 5050 - https://www.adafruit.com/product/1507 

http://saberigniter.com/NECreeRGB.aspx
https://www.adafruit.com/product/1507
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 3535 (Skinny) - https://www.adafruit.com/product/2969 

That being said, Adafruit’s strips are really over-priced compared to the competition. Sparkfun has very similar 

strips that are much more affordable, but still very high quality. 

 3535 (Skinny) - https://www.sparkfun.com/products/14732 

 5050 RGBW - https://www.amazon.com/BTF-LIGHTING-Individually-Addressable-Flexible-Non-

waterproof/dp/B01N0MA316?ref_=bl_dp_s_web_14106955011&th=1 

Naigon’s Electronic Creations does NOT recommend the Alotive brand strips from Amazon, as they are a cheaper 

LED and seem to cause addition line noise from internal testing, though these strips do now work with our 

products. 

3.2. SPARK COLOR 3 LAYOUT 

Before getting started, it is important to familiarize yourself with the layout of Spark Color 3™, TruDrive™ and all of 

the pads on the board. This will help in wiring up the board for use in a saber. 

The following two diagrams show the important components of Spark Color 3™, with an accompanying table 

describing what each component does. 

 

 
Figure 1 – Important components on the back of Spark Color 3™. 

https://www.adafruit.com/product/2969
https://www.sparkfun.com/products/14732
https://www.amazon.com/BTF-LIGHTING-Individually-Addressable-Flexible-Non-waterproof/dp/B01N0MA316?ref_=bl_dp_s_web_14106955011&th=1
https://www.amazon.com/BTF-LIGHTING-Individually-Addressable-Flexible-Non-waterproof/dp/B01N0MA316?ref_=bl_dp_s_web_14106955011&th=1
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Name Label Description 

1. Micro SD card 
holder 

NA Holds the Spark Color 3™ SD card. Ensure the card is fully 
inserted before applying power to Spark Color 3™. 

2. TruDrive™ 
board 

LED DRIVER PCB Driving board that can power two high-power LEDs from Spark 
Color 3™. 

3. Battery +/- 
pads 

BAT+, BAT- Hook power and ground from a 3.7v Li-ion pack here. 

4. Speaker pads SPKR Hook a 1.5-2.0w, 8ohm speaker here. 

5. Accent 
Common + 

VLED+ Used to power all three of the accent LEDs. Optionally, 
additional static LEDs can be powered from this pad. The 
output is 3.3v, and it is rated at 200mA. 

6. Accent LED 
pads 

1,2,3 Each pad can hold one 20mA accent LED. These LEDs will be 
sequenced by the chosen pattern. 

7. LED connect 
pads 

1,2,3,4 Pads that hook the TruDrive™ board to the Spark Color 3™ 
main board. Pad #4 is not used. 

8. Color Pads C1-, C2-, C3- Hook the main LED and flash LED cathodes to these pads. 

9. Switch Pads MAIN, AUX Pads for the switches. MAIN can be a momentary or latching, 
aux must be a momentary. Make sure to select the correct 
type of switch for MAIN in the Config Editor. 

Table 1– Description of each component. 

3.3. TRUDRIVE™ SEPARATION  

Spark Color 3™ will come by default with the TruDrive™ attached to the main board. If it is desired to have the 

TruDrive™ separate from the main board for the install, then you can detach the two boards. 

To separate them, place a mouse pad at the edge of a table, and place Spark Color 3™ on the pad with the seam 

where TruDrive™ meets Spark right at the edge of the table, so that the entire TruDrive™ is off the table and the 

entire Spark™ is on the mouse pad. Then with one palm press and hold Spark Color 3™ to the pad, and gently use 

your other hand to press the other board until it starts to snap. Then simply wiggle the TruDrive™ back and forth 

until it comes free. 

It is important to note that once the board has been removed it cannot go back on; plan accordingly before 

separating the boards. 

4. WIRING DIAGRAMS 

The following diagrams are the most common to get your board up and running. 

Note: It is very important that the correct resistor be used between the negative pad of the LED and C1-, C2-, C3- 

and C4- to prevent burning out the LED for warm color LEDs. For Rebel LEDs if a red, red-orange or amber LED is 

used, then a 1ohm 1watt resister is needed. For any other Rebel colors a resistor is not needed. The STTH2L06 

diode can be used in place of the resistor and it is a slightly smaller part. 

4.1. BASIC WIRING 

This is the most basic wiring that is possible to get the board up and running. It is great for testing your Spark Color 

3™ on the bench, or if you are doing a simple install into a saber that will have a removable battery. 
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Note that with this setup since there is only one LED it is important to ensure that the first color-set has SC1 set to 

a non-zero value, preferably 185 or greater, to ensure that the board is connected properly. Otherwise, the main 

LED will not come on when the saber is ignited, making testing more difficult. The default files do have the first 

font set to have the first LED on, so testing this with the default works well. 

 

Figure 2 – Basic wiring for Spark Color 3™. This will drive a single main LED and would require a removable battery for charging. Note that a 

resistor between the blue wire and C1- of TruDrive™ would be needed if the LED is red, amber, or red-orange. 

4.2. FLASH WIRING 

Wiring a basic setup to have a TriCree LED with two die of one color and a third die for a flash color is a possible 

choice for Spark Color 3™, though the RGB wiring is recommended to take advantage of all the color-mixing 

features. This setup allows for a bright single-color blade while still allowing for an effect/aux color for blast and 

clash/lockup effects. The wiring diagram below shows how to utilize that setup. 

The preferred LED to use for this setup is the TriCree, as it has an optic made specifically for this configuration, and 

it has a great balance of brightness with good efficiency, so it doesn’t waste too much power. It also produces a 

very even blade when diffused and sanded. The X2/X4 previously recommended is no longer preferred as it’s optic 

doesn’t allow enough of the brightness down the tube evenly. 
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Figure 3 – Wiring a Spark Color 3™ for a main blade and a flash color. Note that the colors can be mixed, so it is possible to have a mix of the 

two, or utilize the flash color as the main blade color for one of the three fonts. R1 is needed if the die is Red, Red-orange, or amber. 

For this setup with the bridging shown in FIGURE 3, it is recommended to set SC1 and SC2, C1CLSH and C2CLSH, 

and C1BLST and C2BLAST to the same values for a given font to ensure that both LEDs of that same color are 

enabled. 

4.3. RGB WIRING 

Spark Color 3™ supports full RGB color mixing. This diagram shows how to hook up an R/G/rB die for the ultimate 

color mixing. The recommended LED to use by far is Naigon’s Electronic Creations own NECree RGrB v2. It utilizes 

the highest binned XP-E2 Cree dies, in a common-positive wiring with the STTH2L06 diode already installed, so NO 

EXTERNAL RESISTORS ARE REQUIRED for the LED. 
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Figure 4 – RGrB wiring utilizing the NECree RGB v2 LED. Note that no external resistors are needed with this LED. 

4.4. RGBA/RGBW WIRING 

With Spark Color 3™, a fourth die can be utilized for even more flash effects, and a bit more vivid (and efficiently 

mixed) colors. The following diagram shows this wiring for a CREE XML RGBW LED, but a quad-rebel or a quad cree 

works as well. In general it is recommend to stick with a standard RGB setup for simplicity, but for folks that really 

want to do a lot of white/silver colors this may be a choice. 
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Figure 5 – Cree XML RGBW LED. This allows having a white die, which makes some colors mix more efficiently and a bit brighter clash effects 

for some colors. Similar wiring for a quad rebel or quad cree would work as well. 

4.5. COLOR MATCHING CRYSTAL MATCHING 

With the advent of color mixing many people are wanting a blade matching crystal chamber to go along with their 

build. If you want to experience this thrill, then look no further! The following diagram shows how to get this LED 

wired and working. 

It is important to note that this wiring is applicable to in-hilt LED setups only; when doing a blade matching crystal 

for a pixel string, an individual pixel must be used. 
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Figure 6 - Wiring with an RGB crystal chamber. This will have an RGB led that matches the blade color and pulses with the blade. Note that 

all three pins of the REB LED have a resistor since power is coming from the battery. I recommend a 22-33ohm for R1, and a 1ohm each for 

R2. 

4.6. RUMBLE MOTOR WIRING 

When not using a 4th die the C4 pin can be used to run an accessory, such as a rumble motor or another special 

accent LED. 

The following diagram shows the use of a low power (3.3v) shaft-less motor that can be purchased from Pololu 

here. If using something that requires more voltage than 3.3v, the power could be drawn directly from the battery 

instead of the VLED+ pin. 

http://www.pololu.com/catalog/product/1636
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Figure 7 – Diagram with a small shaft-less motor running of the C4- pad. For accessories that require more voltage/amperage, direct battery 

power can also be used. 

4.7. CROSS-SABER WIRING 

For those that want to mimic the saber with two side quillion or cross-guard blades that have the delayed 

extension, the following wiring diagram is provided. This supports a saber where all three blades are the same 

color, with a secondary flash color for either the main blade or all blades. 

I’ve provided the wiring for a TriCree though any other LED would be similar. If using a TriCree I recommend only 

hooking up two of the three die for the side LEDs to prevent battery drain and to ensure that a single channel does 

not get too hot. 

Note that when using Red or Amber die resistors would be needed between the die and the appropriate Cn- pad. 
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Figure 8 – Wiring for the Cross-Saber feature. This is for a single color blade and side guards, but allows for a FOC color on the main blade. 

Note that 4 resistors or STTH2L06 diodes would be needed for a Red/amber color, labeled as R1-R4 in the diagram. This wiring also utilizes a 

single AV switch, so the configuration would need to reflect that (one button or one button with motion). Finally, c1Color and c2Color could 

be set independently if the die off C2- was a different color to allow for the flash-clash effects. 

After wiring this, make sure that not only Cross-Saber is enabled in the master section, but each font where it is 

desired for the side LEDs to be on will also need C4PERCENT set to 95 in the master, and then SC4 set to a non-

zero value for each color-set where the secondary blade(s) should be on. For a simple static blade then just set all 

three values SC4, SC4BLST, SC4CLSH to 255. However, if it is desired for the side blades to only come on for flash 

effects, set SC4 to 0, but the rest to 255. It is also possible to turn them down some to something like 155 to save 

some power. For SC1, SC2, and SC3, they could be set the same if the TriCree is all red, or set independently to 

have SC3 off for the main blade and enabled for the other effects, allowing the main blade to have a flash-clash 

color. 

4.8. X-SABER WIRING 

When using the external XDrive, it is possible to have a cross-guard saber with full color mixing on the main blade 

and the two quillions. This specific example uses 3 NECree RGrB LEDs, but any RGB LED could be used. 

Note that with this configuration it is recommended to use a 26650 since the runtime drain for this setup is quite 

high; if that battery cannot be used at least use the KeepPower 18650 3120mAh as it has a 15amp PCB and does a 

bit better with the higher amperage draw. 
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Figure 9 – Wiring with the XDrive for the X-Saber feature. If TriCrees are used then 3 reisstors/STTH2L06’s would be needed for the red die. 

For this wiring, the colorset config(s) will need to be setup just like for the single-color side blades. See 4.7 CROSS-

SABER WIRING on how to do that. Note that SC4 will determine if the side blades are on/off, but SC1, SC2, and 

SC3 set the actual colors for both the main and side blades. 

4.9. PIXEL STRING WIRING 

Spark Color 3™ fully supports Pixel string blades, aka WS2812B, out of the box! All that is needed is a separate SD 

card with the string blade /dat and /appNN files. These strings are not only super bright, but they also support 

Extension and Retraction Flow, allowing for super-realistic growing and shrinking blades, and Impact Blast™, the 

ability to replicate bolts hitting the blade in defined spots. 

The Pixel strings are quite easy to work with as there are only 3 wires coming out of each strip. When using the 

5mm LEDs, these 3 wires are exactly what will be needed. When using the 144 led/meter strips, the three 

connections will need to be run in parallel for each strip to light in the same way as the others. 

NeoPixel blades can be built from the 144 led/meter strips: 

https://www.adafruit.com/products/2969 

or by building a blade from 5mm NeoPixel individual straw-hat LEDs: 

https://www.adafruit.com/products/2969
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https://www.sparkfun.com/products/12999 

To see how awesome these look, check out the release video here: 

https://www.youtube.com/watch?v=nP17IWlQS6M 

IMPORTANT – Because the Pixels use a completely different driver system, the #2-#4 pins are used as simple 

grounds when using a string blade. This means that if you want to wire a blade matching crystal chamber, you will 

need to use a NeoPixel individual LED wired in parallel with the main blade. Rumble motors are thus not 

supported. 

 
Figure 10 – Wiring a triangular prism style WS2812 blade with 3 parallel strips. It is also possible to do two strips back to back, though that 

increases the vertical shadowing and doesn’t look as good when looking right at the seams. Notice the extra ground wire between the 

TruDrive and main board; this is recommended to ensure adequate amperage can flow to the string. 

After purchasing your strip, make sure to use the NEC Editor software to configure the blade type that you have 

installed, as this needs to be set appropriately to ensure that the blade is working correctly. 

4.10. FULL WIRING 

This diagram shows how to wire a recharge port along with accent LEDs and the NECree RGB v2 LED, allowing all 

the features of Spark Color 3™ to be utilized. The recharge port also acts as a kill key, where pushing a kill plug into 

the port will stop power from getting to the board.  

https://www.sparkfun.com/products/12999
https://www.youtube.com/watch?v=nP17IWlQS6M
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Figure 11 – Full wiring using all accent LEDs and a recharge port/kill key combo. This wiring will allow all features of Spark Color 3™ to be 

experienced, including full RGrB color mixing. 

5. CONFIGURATION EDITING 

Once Spark Color 3™ has been wired according to the wiring above then it will work immediately with the default 

configuration. However, changing the fonts and effects is completely possible and encouraged by using the NEC 

Editor. The NEC Editor is the new replacement for the old Config Editors; the NEC Editor is great in that it can edit 

every board, and can also work on both Windows and Mac! 

5.1. INSTALLATION 

On Mac, unzip the file. Double click the DMG. When the NEC Editor pops up, just drag it over to the APP folder, and 

this will install the app. I’ve found that on some versions of Mac OS it is necessary to grab near the word NEC 

Editor as opposed to the board icon when dragging; trying to grab the icon I results in no action being taken. 
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Figure 12 – Installing the NEC Editor on Mac. Make sure to select the “NECEditor” text below the icon to select and drag to the Applications 

folder. 

On Windows, unzip the file, or just double click to open the zip. Double click the installer to start the install 

process. It may be necessary to click OK on the warning that changes are going to be made by your computer. 

 

Figure 13 - In Windows, double click the installer exe to bring up the install wizard. 
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5.2. COPY FILES TO YOUR MACHINE 

Before opening NEC Editor you will need to copy the files you want to edit from the micro SD card to your local 

computer. First, insert your micro SD card into your computer using your SD card reader. If you do not currently 

have one, I recommend this cheap one off eBay: Micro SD card. 

Then, open a new window and find a place to put a new Spark directory. In this example the Spark directory will be 

placed right on the root c:\ drive. Create a new directory and name it “SparkColor”. Then, inside that directory, 

create another folder with the name of your saber. In this example, “Saber1” will be used. 

Now, with both the Saber1 empty directory open and the micro SD card opened, select all the files from the micro 

SD card, and drag them into the Saber1 directory. When done, all the files should be copied to your hard-drive as 

shown below. 

 

Figure 14 – After creating a new directory called “c:\Spark\Saber1”, the files are copied from the micro SD card (on the right) to the new 

Saber1 folder (on the left). From here edits can be made to the files from the config editor. 

5.3. LAUNCHING THE APPLICATION 

To launch the NEC Editor in Mac, you can use spotlight search or launch, and then type “NEC” to filter to the NEC 

Editor. Once it appears, double-click to launch. 

On Windows, double click the desktop items, or use the program menu to find NEC Editor, and click it. 

Once launched you should see the program as below: 

http://www.ebay.com/itm/New-USB-2-0-SD-Micro-SD-TF-T-Flash-Memory-Card-Reader-/160575697242?pt=US_Memory_Card_Readers_Adapters&hash=item25630eb15a
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Figure 15 – NEC Editor launched after installation. 

You can then go to File->Open, and the open dialogue will appear. Navigate to the “c:\SparkColor\Saber1” folder 

and then go into one of the fonts to edit. When you see the SCONFIG.INI appear in the window, double click it or 

select it and click open to load the program for editing this font. Note that you must select the SCONFIG.INI file; it 

is not a folder selection. 
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Figure 16 – Navigate to “c:\SparkColor\Saber1” in the window, and then select either one of the fonts to edit. When you see sconfig.ini, 

double click it to open editing for the font. 

5.4. CHANGING SOUNDFONTS 

Changing sound fonts was never easier than with the new NEC Editor. With the auto-sync of the app open you can 

switch fonts easily even when directly editing a font in the NEC Editor. You also swap the font before opening it for 

the first time. 

To copy a new sound font, first go to the font that you want to change. In this example it will be 

“c:\SparkColor\Saber1\font1”.  Navigate to that directory in explorer and then select both of the .wav files 

(font.wav and multi.wav), and all the wav folders. I find the easiest way to do that is to select all (edit->select all or 

ctrl+A), then hold control and click the config.ini and accent.ini files (along with the backup folder if already 

present) to unselect those files. Then you can delete the original files to the recycle bin. Make sure you have a 

separate backup of these waves before doing this. 
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Figure 17 – Delete the existing font by selecting all the files, then hold control and uncheck ‘accent.ini’, ‘config.ini’, and ‘backup’ if it is 

present. Then the selected wav files can be deleted or cut and pasted into a backup location. 

After the wav files are removed and all that is left is the config files and backup folder, you can copy in all the new 

wav files from a new font. You can find these from online saber sound websites, and there are some free ones 

available from my website as well: http://SaberIgniter.com/fonts.aspx. 

Once the files are copied, then either open the font in the NEC Editor, or if the NEC Editor was already opened to 

this font, simply switch back to the NEC Editor, and it will auto-sync the font numbers from disk, and it will auto-

convert them to 22050Hz, mono with appropriate headers! 

http://saberigniter.com/fonts.aspx
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Figure 18 - After making changes on the disk simply switch back to the app and it will sync with the correct numbers. In this case the 

clsh08.wav was deleted, but this will even work for swapping out an entire font. 

5.5. EDITING SETTINGS 

With the file open, you have access to all the configuration settings from spark. Unlike Igniter™ which has a bunch 

of sliders for individual parameters, Spark Color 3™ has simple dropdown values that represent high-level pre-

configured features. This makes editing a breeze and removes any confusion with what certain settings control. 

The following sections go over each tab of the config editor, and give a description on how the settings are used. 

5.5.1. MASTER 

The master tab in the NEC Editor contains global settings that generally apply to every font, not just the current 

loaded font. The following settings are utilized in the master tab for Spark Color 3™: 
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Figure 19 – Screen shot of the master tab. 

C1PERCENT, C2PERCENT, C3PERCENT – drive settings that control the percentage of the LED. Use these to turn 

down the overall brightness of a die regardless of what color value is set. For example, setting C3PERCENT to 185 

with cross guard will always turn down the side blades even if their color is set to 255, allowing some power saving 

for those short blades. 

ORIENTATION sets which way the board is facing in the hilt, so that the board can be aware of the saber’s angular 

direction (ie which way it is pointing). 

X-SABER is the amazing new feature that allows an RGB color-mixing cross-guard saber! After enabling this make 

sure to set each color-set’s c4 values to non-zero in order for the side LEDs to turn on; see ERROR! REFERENCE 

OURCE NOT FOUND. ERROR! REFERENCE SOURCE NOT FOUND. for more details on wiring and settings. 

PIXEL TYPE sets which specific pixel protocol should be used for the blade. When purchasing pixel strips, it should 

be noted by the manufacturer on which setting to choose. Choose one of the RGR options if the red and green are 

reversed in color from the NEC Editor. When using an in-hilt LED, this setting is not used. 

REQUIRE AUX BUTTON WHEN TWISTING requires the aux button to be held when doing the twist motion to 

advance to the next color-set. This prevents unwanted color shifts when swing the saber or dueling. 
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MBUTTON defines if the main button is either latching or momentary. If set to latching, do not enable SWAP 

BUTTONS, as that is only supported for two momentary switches. 

The SWAP BUTTONS setting is used to swap which buttons are main and aux. This is especially useful if the two 

buttons are inside a control box, as it allows the top/bottom button to be whichever the user prefers. Think of this 

as look inversion for console shooter games. 

When USE BOOT SOUND is enabled, the default boot.wav from the root will be played. Disabling this setting will 

boot with the first sound font’s font.wav. 

LOWPWR defines the length in seconds before the saber goes into Low Power mode, which is where the accent 

LEDs shut off and the motion for the menu is disabled. Handy for cons as it saves a lot of power when hanging on 

the belt since the accents drain a lot of power. 

NSTRP – Applicable only when using a WS2812 (NeoPixel) blade. This defines the length of a single strip of the 

blade – for example, when using a triangular prism blade, if the lengths of each strip are 144, 145, and 144, then 

choose 145 or the side with the maximum length. Currently the maximum number supported is 255. 

After making all the edits desired, to go File->Save in the program to save the new configuration settings. Repeat 

for any other fonts where the effects are going to be configured before transferring the files back to the micro SD 

card. 

5.5.2. MOTION 

This section contains the motion sensitivity settings. Each setting is described below. 
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Figure 20 – Screenshot of the Motion tab. 

LSWGTHRESH – Swing threshold to determine the sensitivity that means a low swing is occurring. These are the 

long, drawn out swings that will be played at a bit quieter volumes. Zero (0) means very sensitive, 255 means it will 

be quite a bit of force before the low swing is triggered. 

SWNGTHRESH – Swing threshold to determine the swing sensitivity. This is on top of the low swing threshold to 

ensure there is no overlap. Zero (0) means very sensitive, 255 means it takes some movement before a swing will 

register. 

SLSHTHRESH – Slash threshold to determine the sensitivity of when a slash is registered. A slash is a fast/hard 

swing. Note that this setting takes effect after SWNGTHRESH, meaning it is impossible to set the values in such a 

way that it is impossible to register one or the other. 

MAXSWNG – Defines the maximum value that a swing will take. Higher numbers will give more variance to the 

dynamic range for the volume/pitch of swing sounds; lower values will make them all play at similar volumes. 

CLSHTHRESH – Clash threshold to determine the sensitivity of when a clash is registered. Zero (0) means hardly 

any impact will trigger it, 255 means a very hard whack is required. 
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GYROXTHRESH – Only applicable when using a single button. This determines how hard of a twist is required 

before the motion is recognized by the system. Zero (0) means not much twist will be required; 255 means it 

requires a very hard force. 

GYROYZTHRESH – Only applicable when using a single button. This determines how much play in the other 

directions is allowed when registering a twist. The higher the value the more play is allowed, making the effect 

easier to perform. Note that this is the opposite as the other threshold values in which higher values make the 

effect more difficult to trigger. 

 

5.5.3. BLADE COLOR 

A unique feature for Spark Color 3™, this tab contains the ability to edit each color-set. 

First, use the dropdown to select the desired color-set to edit. Once chosen, the sliders for the blade color, clash 

color, and blast color are loaded. Then, modify each C1, C2, C3, and optionally C4 to match the blade color mix. 

Assuming the standard RGB color scheme and that C1 is Blue, C2 is Green, and C3 is red, you can use a site like 

colorschemer.com to find colors and enter them into the tool. 

If you want to add a new color-set just go to the file explorer, copy the colr1 folder, rename it to colrN (where N is 

2-9) to the next available number, and then switch back to the Config Editor program. 

To dial in a specific color with RGB, I recommend going to the online selector here: 

https://galactic.ink/sphere/ 

It helps choose colors and then gives the r,g,b representation of those colors. You can use the bottom 3 sliders to 

help select a color to input. Remember that you need to reverse the order as they use r,g,b not b,g,r. 

If you are using a TriCree with 2 or more die the same color, just always treat those two as the same value. For 

example, for a B,B,G die, you can set c1Color = 255 and c2Color = 255 to get the blue at full brightness. If you want 

a cyan color you might do SC1 = 80, SC2 = 80, and SC3 = 255. 

You can also use the simulator to see the color that is selected. Note that by default the program assumes BGR; 

this can be changed in the Options->Color Settings menu. Note that changing this will have NO effect on the actual 

colors that actually show up on the saber; rather, you set this to match the saber install. This is why I HIGHLY 

recommend installing BGR so that all the examples and colors line up to the defaults. 

https://galactic.ink/sphere/
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Figure 21 – Color-set editing in the NEC Config Editor. Edit each color-set from this tab, regardless of what font is currently loaded. 

5.5.4. BLADE 

The blade tab holds the settings for the blade effects. The colors are controlled by the color-set editing from the 

Blade Color tab. See the section 5.5.3 BLADE COLOR for more information on editing each color-set. 
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Figure 22 – Screenshot of the Blade Effects tab. 

BLDEEFFECT – Defines the pulsing effect for the blade, choosing either a pulsing or flickering style. Use the 

simulator to get an idea of how the effect will look in the saber. 

REQUIRE HOLDING AUX W/TWIST (SCTWST) – Enable this to require holding the aux button while doing the twist 

motion to advance fonts. Unchecked means that the color shift will occur with just the twist. 

INLEN – Length in milliseconds for the retraction effect. Choose zero (0) to have the effect match the length of the 

file. 

OUTLEN – Length in milliseconds for the extension effect. Choose zero (0) to have the effect match the length of 

the file. 

5.5.5. CLASH 

The Clash Tab contains the clash effect settings. The color is controlled by the colors in each color-set. To edit the 

color-sets, go to the Blade Color tab; see more about this in 5.5.3 BLADE COLOR. 
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Figure 23 - Clash tab contains settings for the clash color and clash effects 

CLSHEFFECT – Defines the clash effect for the blade. Use the simulator to get an idea of how the effect will look in 

the saber. 

LOCKUPTYPE – Defines how the lockup is engaged and disengaged using the secondary button. 

USE ALTERNATING CLASH (ACLSH) –When enabled, the clash will vary between the clash color and blade color 

for a more dramatic effect. 

CLSHWAITLEN – Amount of time (in milliseconds) after a clash before a blast/clash/swing can interrupt. 

BLOCKLEN – Length of time (in milliseconds) to hold the button before it is registered as a lockup. 

5.5.6. BLAST 

The Blast Tab contains the settings for the blast effect. The color is controlled by the colors in each color-set. To 

edit the color-sets, go to the Blade Color tab; see more about this in 5.5.3 BLADE COLOR. 



Page | 33 

 

 

Figure 24 – Screen shot of the blast settings in the NEC Editor. 

BLSTLEN – Length (in milliseconds) for the blast effect to play. Setting to zero matches the length of the file. 

NIMPTBLAST –Applicable only when using a WS2812 (NeoPixel) blade. This setting defines the size for the Impact 

Blast™ feature. This value should be between 0 and half the length of the blade, as it defines where the impact 

range should occur from the middle. Setting to zero (0) will disable the feature. 

5.5.7. AUDIO 

The audio tab contains some settings directly related to the audio. These settings are described in detail below. 
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Figure 25 – Screenshot of the Audio tab. 

LINEAR HUM/IN/OUT –Enable this setting to have the hum, extension, and retraction sounds play in order as they 

appear on disk instead of being random order. 

LINEAR ACTION –Enable this setting to have the swing, slash, clash, blast, and lockup sounds play in order instead 

of being randomly selected. 

HUMSTART – Length in milliseconds in which the hum starts playing before the end of the extension sound. For 

example, if the extension sound is 1,000ms (1 second), and this is set to 400ms, then the extension will play 600ms 

before the hum starts. 

VOLHUM – Volume for the hum sounds. Values go from 0 to 16, 0 being completely off and 16 being full volume. 

VOLEFF – Volume for the effect sounds. Values go from 0 to 16, 0 being completely off and 16 being full volume. 

5.5.8. ACCENT 

Accent settings tab. Unlike Igniter™ which has complicated accent settings, Spark Color 3™ has simple drop-downs 

to run the accents. This allows for easy setup and ensures a nice pattern. 
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To change the accent pattern for each mode, simply choose the pattern from the drop down for that mode. To see 

the pattern in the simulator, make sure that the desired mode is chosen from the Accent mode dropdown, which 

in the NEC Editor is right above the 8 accent LEDs, above the start and stop buttons for the accent portion of the 

simulator. 

 

Figure 26 – Screenshot of the Accent tab. Use the individual dropdowns to set each effect. The dropdown is used to indicate to the simulator 

which one should be running in the simulator for inspection. 

 

5.6. GENERATE DUAL OUT SOUNDS FOR CROSS-SABER 

The best experience for Cross-Saber is to utilize the new dual out sounds, named DOUTNN.WAV, where NN is a 

number 01 to 99. Basically, these files would be a second extension mixed in the original at the delay of humStart 

in the config, which would make a second delayed sound when the second blades turn on. Creating these manually 

would be a tedious task. However, with the new Create Dual Out Wavs function in the config editor, it is a breeze. 

For each font you just open the font, go to Edit->Create Dual Out Wavs, and click. That’s it; one dual out wav will 

be created for each out wav for the font, with the secondary extension mixed at the delay of humStart set in the 

config. 
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Once created, just save the font so the number is updated any the font will now use the dual out sounds if Cross-

Saber is enabled. Note that if there are no dual out sounds the normal out ones will be used so this is not a 

mandatory step, but does enhance the overall experience. 

5.7. FORMAT MICRO SD 

I no longer recommend using Windows built-in format tool to format the SD cards, as it doesn’t do a true UNIX 

style format. Instead, it is much better to use a good 3rd party tool, such as SDFormatter. 

https://www.sdcard.org/downloads/formatter_4/ 

This tool will properly format the SD card for use with all my boards. 

Upon launching the tool the window below will be shown 

 

Figure 27 – Using SD Formatter to format the micro SD card for use with any of my products, including Spark™, Spark Color™, Igniter™, and 

Sound Hornet™. 

To format an SD card, simply select the drive of the micro SD card from the Select card dropdown, type a name 

into the Volume label field, ensure Quick Format is chosen, and hit format, clicking yes on the prompt that 

appears. This will format the card and erase the existing contents, ensuring it is ready for use with your board. 

Note that I do this for every card that gets sent with the board, but this is necessary for those that are changing 

fonts and/or have a new SD card. 

https://www.sdcard.org/downloads/formatter_4/
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5.8. COPY FILES BACK TO THE MICRO SD 

To copy the files back, simply move all the files from the “c:\Spark\Saber1” directory to the root of the micro SD 

car. This will ensure that the files are written well and can be accessed quickly by Spark Color 3™. Once this step is 

done the micro SD card is ready to be loaded back on to Spark Color 3™ to enjoy the new settings and fonts! 

6. ERROR CODES 

Igniter 3™ comes equipped with an on-board SMD error LED, which blinks to indicate certain SD or read failures, 

making install a snap. When an error occurs, the led will blink a certain number of times, and then will pause for 1 

second. Getting the number of blinks can then be used to determine the failure, by using the table below. 

The following table shows the number of blinks and which error it represents. Errors in red are fatal errors and the 

board will not be responsive until it is power cycled. 

Num of Blinks Error 

2 Bad card, empty card, not formatted 

3 DAT not found 

4 Boot wav not found 

5 Main wav read error 

6 Config file not found 

7 Effect wav not found 

8 Effect incorrect format 

9 SD card locked 

Table 2 – Error codes for the accent error LED. 

7. SABER OPERATION 

To use your saber, with the micro SD card inserted and the wiring correctly completed, insert the battery or pull 

the kill key. You should hear the boot sound or first font sound play (depending on the config setting), and you 

should also see the first accent LED blinking rapidly. After this your saber will load into idle mode for the first font. 

There are three main modes of operation for the saber: Idle mode, Running mode and Tracks mode. These two 

modes will be discussed in detail in the next sections. 

7.1. IDLE MODE 

Idle mode is when the saber is loaded for a font but not running. This is where the accent LEDs are running the idle 

pattern, and the saber is ready for use. In this mode there are two ways to interact with the saber. The first is 

hitting the aux button to advance to the next font. When you are on font three, hitting aux goes back to font1. 
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Spark Color™ always assumes that there are 6 fonts present on the config card, so make sure they are always 

present on the micro SD card. 

The other way to interact with the saber is by hitting the main button. This puts the saber in running mode. For 

more details on that see the next section. 

6.1.1. IDLE MODE INTERACTION TABLE 

The following table lists all the interactivity that is possible with the saber while in idle mode. 

Entry Label Action Description 

Main button MAIN+/- Press/Latch Pressing the main button (latching when it is a latching switch) 
puts the saber into running mode for font1 and font2, and 
font 3; for saber tracks, it is used to engage the blade. 

Aux button AUX+/- Press Advances to the next font. 

Aux button AUX+/- Hold + point 
saber down 

Holding the Aux button while the saber is pointed straight 
down enters saber configuration. 

Table 3 – Possible interactions in idle mode, when the kill key is pulled but the saber is not in the hum effect. 

7.2. RUNNING MODE 

When the saber is running, there are many actions that are possible. Swings, Blaster Blocks, Clashes, Lockups and 

retraction all become available. Further, this is when the main LED runs and accent LEDs follow the patterns for the 

actions performed. A detailed description on how to interact with the saber is given in the following subsection. 

To stop the saber from running, simply hold down the main button (unlatch if it is a latching switch) until the 

retraction sound and effect happen. The saber will then return to Idle mode. From here you can re-insert the kill 

key or remove the battery. Do not remove power when the saber is running, as this can cause the micro SD card to 

get an incorrect formatting, and then it would need to be reformatted. Granted this is very rare but it is better to 

put the saber into Idle before disconnecting the power. 

Specifically for Spark Color 3™, the color-set can be advanced when the saber is running. Simply perform the “flick 

the wrist” motion (aka the DualPhase™ motion from Igniter™) to advance the color-set; if SCTWST is enabled for 

this font, then hold the aux and do the motion. 

6.2.1. RUNNING MODE INTERACTION TABLE 

The following table lists all the interactivity that is possible with the saber while in running mode. If the One Button 

is enabled in the config, please see the interaction guide for one button: 0 TABLE 4 – INTERACTIONS POSSIBLE 

when the saber is running, and two buttons are installed. 

. 

Entry Label Action Description 

Aux Button AUX +/- Press Pressing the aux button engages Blaster Block mode. Once in 
this mode, swinging the saber will perform EzBlaster™, where 
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another Blaster Block will be performed. Keeping the saber 
still will cause the mode to exit. 

Aux Button AUX +/- Hold Holding the aux button is the second way to engage the 
Lockup effect; the primary way is by EzLockup™ - tapping the 
aux once after performing a Clash. Depending on the chosen 
config setting, either releasing the button or tapping it again 
will cause the mode to exit. 

Aux Button AUX +/- Press (in 
Clash) 

Pressing the AUX button will perform EzLock™; immediately 
after the press the Lockup sound will play when in Clash 
mode. This is the preferred way to perform a clash on 
Igniter™. 

Hold Aux + Hit 
Saber 

AUX +/- Clash Holding aux and then doing the clash will do the EzLock™, 
bypassing the clash and immediately playing the lockup 
sound. 

Swing saber NA Swing Swinging the saber causes a single swing sound to be played. 
If the swing is performed rapidly then a Slash sound will be 
performed. 

Rotate saber; 
Rotate saber + 
aux 

NA Rotate Rotating the saber (or while holding aux with SCTWST 
enabled) will advance the color-set to the next color, loading 
in the new blade, clash and blast colors. 

Hit saber/Blade CS Clash Hitting the saber against something or hitting your hand on 
the hilt will cause the Clash sound to play. To return to 
running simply wait for the clash to finish. 

Table 4 – Interactions possible when the saber is running, and two buttons are installed. 

7.3. SABER TRACKS 

The menu in Spark Color 3™ cycles through each of the 3 fonts, and then to the special Saber Tracks font, before 

cycling back to the first font. After hearing the “Saber Tracks” audio clip in the menu, you will immediately be 

entered into Saber Tracks™ mode and the first track will immediately start playing. In Spark Color 3™ all the 

TRACKNN.WAV files go in the /tracks folder right off the root of the micro SD card. 

Saber Tracks™ now has the ability to engage the blade while the music is playing! After hearing the music start, 

you can either press and hold the main button (if it is momentary) or latch the main button (if it is latching) to 

ignite the blade. The extension effect will occur followed by the pulsing of the blade. No additional effects will be 

displayed, and now sound effects will play, but the music will stream non-stop. 

The blade color and pulse for Saber Tracks™ in Spark Color 3™ will be selected from the last used font. This means 

that Saber Tracks can be used with any of the 3 blade colors for each of the 3 fonts. 

To turn off the blade, simply hold the main button (if it is momentary), or unlatch the main button (if it is latching). 

Holding the aux button or doing the twist motion for a single button install will exit Saber Tracks and load the first 

font. 

6.2.2. SABER TRACKS INTERACTIVITY 

The following table describes the interactivity for Saber Tracks. 
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Entry Label Action Description 

Aux Button AUX +/- Press Advances to the next track. When the last track file is reached 
it goes back to the beginning. 

Main Button MAIN +/- Hold/Latch Holding or latching the main button will enable the blade, 
doing the extension effect first then the pulse effect. 

Main Button MAIN +/- Hold/Unlatch Holding or unlatching the main button will cause the blade to 
retract if the blade is current enabled. 

Aux Button AUX +/- Hold Holding the aux button will exit Saber Tracks™ and load the 
first font. 

Table 5 – Interactions possible when two buttons are installed and Saber Tracks is engaged. 

7.4. SABER CONFIGURATION 

In Spark Color 3™ the Saber Configuration menu is available. To access this menu, when in the idle mode hold 

down the aux button while the saber is pointing down. From here the two configuration modes can be accessed, 

along with jumping back into the main idle mode of Spark Color 3™. 

Once inside the menu the following interaction is possible. 

Entry Label Action Description 

Aux Button AUX +/- Press Advances to the next mode. The three possible modes are 
Color Editor, Motion Editor, and Spark Color 2™ (main 
firmware). 

Main Button MAIN +/- Press/Latch Enter the current mode. 

Table 6 – Interaction that is possible when in the Saber Configuration menu. 

7.5. COLOR EDITOR 

The Color Editor is an exciting new mode that allows editing of all the colors for every font on the saber. This 

allows easy adjusting of colors selected from the Config Editor, and it even allows completely swapping the colors 

without having to remove the SD card! 

6.3.1. COLOR-SET EDITOR MENU 

The color editor has a menu similar to the menu in Igniter™. This menu is used to navigate the fonts to select the 

one to edit. 

Entry Label Action Description 

Aux Button AUX +/- Press Advances to the next color-set. 

Main Button MAIN +/- Press/Latch This button will activate the saber for editing. 

Aux Button AUX +/- Hold Plays the instructions. 

Aux Button AUX +/- Hold + point 
saber down 

Returns to the Saber Configuration menu. 

Table 7 – Interaction that is possible when in the menu for the Color-set Editor configuration app. 
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6.3.2. COLOR EDITOR EDITING 

Once a font is selected the Color Editor is in editing mode for that font. From here all the changes can be made. 

Entry Label Action Description 

Aux Button AUX +/- Press Increments/decrements the current color value by 10. 

Aux Button AUX +/- Hold Changes between incrementing and decrementing. 

Swing saber NA Swing + hold 
aux button 

Change the action being edited between: Blade, Clash, and 
Blast. 

Rotate saber NA Rotate Rotating the saber will change between the colors blue, 
green, and red. 

Hit saber/Blade CS Clash Increments/decrements the current color by 1. 

Main Button MAIN+/- Hold/Unlatch Holding or unlatching the main button will cause the 
retraction sound to play and all changes made to this font will 
be saved to disk. 

Table 8 – Interaction that is possible when currently editing a color-set in the Color-set Editor app. 

7.6. MOTION EDITOR 

The motion editor is an app that is used to adjust the motion parameters on the fly. Setting these values will 

update the motion settings for every font of Spark Color 3™, as well as the sensitivity of this editing mode. 

Once in the Motion Editor, press the main button to enter editing. From there the following actions are possible. 

Entry Label Action Description 

Aux Button AUX +/- Press Increments the current motion parameter by 10. 

Aux Button AUX +/- Hold Plays the instructions. 

Swing saber NA Swing Plays the swing sound; swinging around the saber gets a feel 
for the current motion settings. 

Rotate saber NA Rotate Plays the Dual Phase™ sound (no color change). Performing 
this motion gets a feel for the current settings. 

Hit saber/Blade CS Clash Plays the clash sound. Performing the clash gets a feel for the 
current motion settings. 

Rotate saber NA Rotate + 
Hold Aux 

Advances to the next motion parameter to edit. Parameters 
are Swing Threshold, Slash Threshold, Clash Threshold, GyroX 
Threshold, and GyroYX Threshold respectively. 

Swing saber NA Swing + 
Hold Aux 

Same behavior as rotating the saber and holding Aux; see 
above. 

Hit saber/Blade NA Clash + 
Hold Aux 

Same behavior as rotating the saber and holding Aux; see 
above. 

Main Button MAIN+/- Hold/Unlatch Holding or unlatching the main button will cause the 
retraction sound to play and all changes made to this font will 
be saved to disk. The saber will then enter the Saber 
Configuration menu. 

Main Button MAIN+/- Hold/Unlatch 
+ hold Aux 
button 

If the aux is held when the main is held or unlatched, then the 
values will not be saved to disk, and the saber will enter the 
Saber Configuration menu. 

Table 9 – Interaction that is possible when the Motion Editor app is engaged. 
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